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NI USB-6008/6009
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Die Geräte NI USB-6008 und NI USB-6009 sind mit acht Analogeingängen für die Schaltung
gegenüber einem Bezugspotential, zwei Analogausgängen (AO) und 12 Digitalanschlüssen
(DIO) sowie einem 32-Bit-Zähler mit Full-Speed-USB-Anschluss ausgestattet. In der
vorliegenden Anleitung finden Sie Bedienungshinweise zu diesen Geräten.

Spezifikationen finden Sie in den Dokumenten Gerätespezifikationen zum NI USB-6008 und
Gerätespezifikationen zum NI USB-6009 auf ni.com/manuals.

In der folgenden Tabelle werden die Geräte NI USB-6008 und NI USB-6009 einander
gegenübergestellt.

Tabelle 1. Vergleich zwischen NI USB-6008 und NI USB-6009

Komponente NI USB-6008 NI USB-6009

   Auflösung für analoge
Erfassung

12 Bit bei differentieller
Schaltung, 11 Bit bei
Schaltung gegen
Bezugspotential

14 Bit bei differentieller
Schaltung, 13 Bit bei Schaltung
gegen Bezugspotential

Maximale Sample-Rate für
analoge Erfassung, ein
Kanal1

10 kS/s 48 kS/s

Maximale Sample-Rate für
analoge Erfassung, mehrere
Kanäle (insgesamt)1

10 kS/s 48 kS/s

DIO-Konfiguration Offener Kollektor2 Jeder Kanal kann
programmatisch als offener
Kollektor oder für die aktive
Ausgabe konfiguriert werden.2

1 systemabhängig
2 Dieses Dokument folgt den NI-DAQmx-Namenskonventionen. "Open Drain" wird dabei als

"offener Kollektor" bezeichnet und "Push-Pull" als "aktive Ausgabe".



In der nachfolgenden Abbildung ist der Aufbau von Geräten des Typs NI USB-6008/6009
dargestellt.

Abbildung 1. Blockschaltbild des NI USB-6008/6009
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Sicherheitsrichtlinien
Im folgenden Abschnitt finden Sie wichtige Sicherheitshinweise, die bei der Inbetriebnahme
und der Verwendung des NI USB-6008/6009 unbedingt zu beachten sind.

Achtung  Verwenden Sie das NI USB-6008/6009 nur so, wie in der vorliegenden
Bedienungsanleitung beschrieben ist. Beim falschen Umgang mit dem Gerät kann es
zu Schäden kommen. Bei einem defekten Gerät sind die eingebauten
Schutzmechanismen unter Umständen nicht wirksam. Alle defekten Geräte sollten
daher zur Reparatur an National Instruments gesendet werden.
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Achtung  Soweit nicht anders beschrieben, dürfen keine Veränderungen am Gerät
vorgenommen werden. Das Gerät darf nur zusammen mit dem in der
Installationsanleitung aufgeführten Zubehör verwendet werden.

Achtung  Das Gerät darf nicht an Orten genutzt werden, an denen
Explosionsgefahr besteht oder an denen entzündliche Gase oder Dämpfe auftreten
können. Wenn auf den Einsatz an einem solchen Ort nicht verzichtet werden kann,
muss das Gerät mit einem vorschriftsmäßigen Schutzgehäuse versehen werden.

Elektromagnetische Verträglichkeit
Dieses Gerät wurde getestet und erfüllt alle in den Produktspezifikationen aufgeführten
behördlichen Anforderungen für elektromagnetische Verträglichkeit (EMV). Die
Anforderungen sind so ausgelegt, dass schädigende Störungen im elektromagnetischen
Umfeld, in dem das Gerät betrieben wird, auf ein vertretbares Maß reduziert werden.

Dieses Gerät ist für den Einsatz an Industriestandorten vorgesehen. Beeinflussungen durch das
Gerät bei bestimmten Anschlussarten oder mit bestimmten Prüfobjekten können jedoch nicht
gänzlich ausgeschlossen werden. Das gilt ebenso für die Nutzung des Geräts in Wohn- und
Geschäftsgebieten. Um Störungen im Radio- oder Fernsehempfang zu minimieren sowie
unakzeptable Leistungsminderungen so weit wie möglich zu vermeiden, sollte das Gerät
ausschließlich der Dokumentation entsprechend angeschlossen und genutzt werden.

Wenn Sie Änderungen am Produkt vornehmen, die nicht ausdrücklich von National
Instruments genehmigt sind, kann im Rahmen der lokalen Gesetzgebung Ihre
Betriebserlaubnis für das Gerät erlöschen.

Achtung  Damit das Gerät die angegebene EMV-Leistung erzielt, müssen
abgeschirmte Kabel und Zubehörteile verwendet werden.

Achtung  Die Empfindlichkeit des Geräts für elektromagnetische Störungen kann
sich durch Anschließen von Leitungen oder Verbinden des Geräts mit einem
Prüfling erhöhen.

Achtung  Beim Anschließen eines Prüflings an das Gerät können Funkstörungen
auftreten, welche die vorgeschriebenen Höchstwerte überschreiten.

Hinweis  Wenn Sie Änderungen am Produkt vornehmen, die nicht ausdrücklich
von National Instruments genehmigt sind, kann im Rahmen der lokalen
Gesetzgebung Ihre Betriebserlaubnis für das Gerät erlöschen.

Auspacken des Geräts
Achtung  Erden Sie sich mit einem Erdungsband oder berühren Sie einen
geerdeten Gegenstand, z. B. ein Computergehäuse, um das Gerät beim Auspacken
vor elektrostatischen Entladungen zu schützen.
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1. Halten Sie die Antistatikhülle an ein Metallteil des Computergehäuses.
2. Nehmen Sie das Gerät aus der Verpackung und prüfen Sie, ob sich eventuell Teile gelöst

haben oder das Gerät anderweitig beschädigt ist.

Achtung  Vermeiden Sie es, freiliegende Pins zu berühren.

Hinweis  Schließen Sie keine Geräte an, die schadhaft erscheinen.

3. Nehmen Sie die anderen Komponenten und die Dokumentation aus der Verpackung.

Lagern Sie das Gerät, wenn es nicht genutzt wird, in der Antistatikhülle.

Inbetriebnahme des NI USB-6008/6009
Gehen Sie zur Inbetriebnahme des NI USB-6008/6009 wie folgt vor:

Hinweis  Informationen dazu, welche anderen Betriebssysteme außer Windows
unterstützt werden, erfahren Sie im Dokument Getting Started with NI-DAQmx Base
auf ni.com/manuals.

1. Installieren Sie die Entwicklungsumgebung (sofern zutreffend) entsprechend der
dazugehörigen Installationsanleitung.

2. Installieren Sie NI-DAQmx3.

Hinweis  Die NI-DAQmx-Software ist auf dem Datenträger in Ihrem
Lieferpaket enthalten und steht zusätzlich auf ni.com/support zum
Download bereit. Die Dokumentation zu NI-DAQmx kann nach der Installation
der Software über Start»Alle Programme»National Instruments»NI-
DAQmx geöffnet werden. Weitere Dokumentation von National Instruments ist
auf ni.com/manuals verfügbar.

3. Befestigen Sie die 16-poligen Schraubklemmleisten entsprechend der folgenden
Abbildung.

3 NI USB-6008/6009-Geräte werden von NI-DAQmx ab Version 7.5 unterstützt.
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Abbildung 2. Gerätebeschriftungen
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4. Bringen Sie die mitgelieferten Beschriftungsaufkleber an den Schraubklemmleisten an.
Wie in der folgenden Abbildung dargestellt, gibt es leere Beschriftungsaufkleber und
Aufkleber mit Pinnummern oder Signalbezeichnungen. Wählen Sie einen der Streifen aus
und drehen Sie ihn so, dass er parallel zum Beschriftungsaufdruck für die jeweilige Seite
lesbar ist. Kleben Sie ihn dann entsprechend der vorherigen Abbildung auf die
Schrägseite der Schraubklemmleiste. Befestigen Sie die Beschriftung auf der anderen
Seite ebenso.

Abbildung 3. Beschriftungsaufkleber für das NI USB-6008/6009
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Hinweis  Der Steckverbinder kann nach Anbringen des Aufklebers nur noch
in die passende Buchsenleiste eingesteckt werden (siehe den Aufdruck auf dem
Gerät).
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5. Schließen Sie das NI USB-6008/6009 über das mitgelieferte USB-Kabel an den
Computer an.

6. Klicken Sie auf dem Desktop das Symbol NI MAX doppelt an, um den Measurement &
Automation Explorer (MAX) zu öffnen.

7. Erweitern Sie Mein System»Geräte und Schnittstellen und sehen Sie nach, ob das
NI USB-6008/6009 aufgeführt ist. Wird das Gerät nicht angezeigt, drücken Sie <F5>, um
die Ansicht im MAX zu aktualisieren. Wenn das Gerät dann immer noch nicht angezeigt
wird, informieren Sie sich auf der Website ni.com/support/daqmx über mögliche
Fehlerursachen.

8. Klicken Sie mit der rechten Maustaste auf NI USB-6008 oder NI USB-6009 und wählen
Sie Selbsttest. Mit dem Selbsttest wird kurz geprüft, ob das Gerät ordnungsgemäß
angeschlossen ist. Nach Abschluss des Selbsttests wird eine Meldung darüber angezeigt,
ob ein Fehler festgestellt wurde. Hilfe bei Problemen finden Sie unter ni.com/
support/daqmx.

Achtung  Damit das Gerät die angegebene EMV-Leistung erzielt, müssen
abgeschirmte Kabel und Zubehörteile verwendet werden.

9. Nehmen Sie ein mehradriges abgeschirmtes Kabel mit einem Aderquerschnitt von 0,9 bis
1,5 mm² und entfernen Sie von jeder Ader etwa 6 mm Isolation. Stecken Sie die Adern
dann in die Schraubklemmen und ziehen Sie die Schrauben mit einem Schraubendreher
fest. Das Drehmoment sollte 0,22 Nm bis 0,25 Nm betragen. Die Pinbelegung des
NI USB-6008/6009 und eine Beschreibung der einzelnen Signale finden Sie im Abschnitt 
Pinbelegung und Signalbeschreibungen.

Verbinden Sie die Abschirmung des Kabels mit einem naheliegenden GND-Anschluss.

Hinweis  Weitere Informationen zu Sensoren finden Sie auf der Website
ni.com/sensors. TEDS-Sensoren (intelligente Sensoren, die dem Standard
IEEE 1451.4 entsprechen) sind auf ni.com/teds beschrieben.

10. Klicken Sie zum Testen des Geräts im MAX mit der rechten Maustaste auf NI USB-6008
oder NI USB-6009 und wählen Sie Testpanels.

Klicken Sie zum Testen der Gerätefunktionen auf Start. Hinweise zur Bedienung des
Testpanels erhalten Sie unter Hilfe. Klicken Sie zum Verlassen des Testpanels auf
Schließen.

Verwenden des NI USB-6008/6009 in einer
Anwendung
Der DAQ-Assistent kann zusammen mit zahlreichen Entwicklungsumgebungen von National
Instruments genutzt werden, um Messkanäle und virtuelle Kanäle zu konfigurieren. In der
folgenden Tabelle sehen Sie alle Programme von National Instruments, die eine Anleitung
zum DAQ-Assistenten enthalten:
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Tabelle 2. Methode zum Öffnen der Anleitung zum DAQ-Assistenten

NI-Anwendung Speicherort der Anleitung

  LabVIEW Wählen Sie Hilfe»LabVIEW-Hilfe und klicken Sie anschließend
auf Erste Schritte mit LabVIEW»Erste Schritte mit DAQ»
Messungen mit NI-DAQmx in LabVIEW.

LabWindows™/CVI™ Wählen Sie Help»Contents und klicken Sie anschließend auf Using
LabWindows/CVI»Data Acquisition»Taking an NI-DAQmx
Measurement in LabWindows/CVI.

Measurement Studio Wählen Sie NI Measurement Studio Help»Getting Started with
the Measurement Studio Class Libraries»Measurement Studio
Walkthroughs»Walkthrough: Creating a Measurement Studio
NI-DAQmx Application.

SignalExpress Wählen Sie Hilfe»Messungen mit NI-DAQmx in SignalExpress.

Im Abschnitt Weiterführende Informationen finden Sie Angaben zu Programmierbeispielen für
NI-DAQmx und NI-DAQmx Base.

Bestandteile
Das NI USB-6008/6009 ist mit einer USB-Buchse, einer Zugentlastungsöse, zwei
Schraubklemmleisten und einer LED-Anzeige ausgestattet (vgl. Abbildung).

Abbildung 4. NI USB-6008/6009 - Draufsicht und Hinteransicht
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USB-Buchse und Zugentlastungsöse
Das NI USB-6008/6009 ist mit einem Full-Speed-USB-Anschluss ausgestattet. Für das USB-
Kabel ist eine Zugentlastungsöse vorhanden, durch die Sie einen kleinen Kabelbinder führen
können. Legen Sie das Kabel wie in der folgenden Abbildung dargestellt in eine Schlaufe und
ziehen Sie den Kabelbinder daran fest.

Abbildung 5. Zugentlastungsöse des NI USB-6008/6009

1

LED-Anzeige
Das NI USB-6008/6009 hat eine grüne LED-Anzeige für den Gerätestatus (vgl. nachfolgende
Tabelle). Wenn das Gerät mit dem USB-Anschluss des Computers verbunden ist, blinkt die
LED fortlaufend. Dadurch wird angezeigt, dass das Gerät initialisiert ist und über die
Verbindung mit Strom versorgt wird.

Tabelle 3. LED-Status/Gerätestatus

LED-Status Gerätestatus

  Ausgeschaltet Nicht angeschlossen oder inaktiv

Eingeschaltet ohne Blinken Angeschlossen, aber nicht initialisiert, oder der Computer ist im
Standby-Modus. Damit das Gerät erkannt wird, muss auf dem
Computer NI-DAQmx installiert sein.

Einmaliges Blinken Funktioniert ordnungsgemäß

Schraubklemmleisten
Das NI USB-6008/6009 wird mit jeweils einer herausziehbaren Schraubklemmleiste für
analoge und digitale Signale geliefert. Die Schraubklemmleisten haben 16 Anschlüsse und
sind für Drähte mit einem Querschnitt von 0,9 bis 1,5 mm² vorgesehen. Die Auswahl der
Beschriftungen für die Schraubklemmleisten ist im Schritt 4 des Abschnitts Inbetriebnahme
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des NI USB-6008/6009 beschrieben. Die Pinbelegung des Geräts und eine Beschreibung der
einzelnen Signale finden Sie im Abschnitt Pinbelegung und Signalbeschreibungen.

Sie können für das Gerät zusätzliche Schraubklemmleisten und Beschriftungsaufkleber
bestellen. Entsprechende Informationen finden Sie im Abschnitt Kabel und Zubehörteile.

Firmware
Die Firmware des NI USB-6008/6009 wird beim Anschließen an einen Computer aktualisiert,
auf dem NI-DAQmx installiert ist. NI-DAQmx überträgt automatisch die passende Firmware-
Version auf das Gerät. Die Firmware-Version kann sich mit neuen NI-DAQmx-Versionen
ändern.

Kabel und Zubehörteile
In der folgenden Tabelle sehen Sie, welche Kabel und Zubehörteile für das NI USB-6008/6009
verfügbar sind. Eine vollständige Liste der Zubehörteile mit Bestellinformationen finden Sie
auf der ni.com-Produktseite des NI USB-6008 und NI USB-6009 auf der Registerkarte
"Preise".

Tabelle 4. Kabel und Zubehörteile des NI USB-6008/6009

Zubehör Artikelnummer Beschreibung

   Zubehörkit für das
USB-6008/6009

779371-01 Vier zusätzliche Schraubklemmleisten mit
Beschriftungsaufklebern und ein
Schraubendreher

Zubehör zur
Prototypenerstellung für
Geräte der Serie
USB-6000

779511-01 Nicht abgeschirmte Prüfplatine zum
Erstellen von
Signalaufbereitungsschaltungen und
Prototypen. Es können bis zu zwei
Zubehörteile pro Gerät verwendet werden.

Hi-Speed-USB-Kabel 184125-01,
184125-02

1 m und 2 m Länge

Achtung  Zum Gewährleisten der elektromagnetischen Verträglichkeit (EMV) darf
dieses Gerät nur mit abgeschirmten Kabeln und Zubehörteilen eingesetzt werden.
Bei der Arbeit mit ungeschirmten Kabeln oder Zubehörteilen sind die EMV-
Spezifikationen nicht mehr gewährleistet – es sei denn, alle ungeschirmten Kabel
und/oder Zubehörteile befinden sich in einem abgeschirmten Gehäuse mit
ordnungsgemäß abgeschirmten Ein- und Ausgängen.
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Pinbelegung und Signalbeschreibungen
In der nachfolgenden Abbildung ist die Pinbelegung des NI USB-6008/6009 dargestellt.
Analogeingänge, die mit einem Bezugspotential arbeiten, sind als "AI x" gekennzeichnet und
differentielle Analogeingänge als "AI x+/-". In der folgenden Tabelle finden Sie eine
detaillierte Beschreibung für jedes Signal.

Abbildung 6. Anschlussbelegung des NI USB-6008/6009
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Tabelle 5. Signalbeschreibungen

Signalname Bezugsanschluss Richtung Beschreibung

    GND — — Masse—Bezugspunkt bei der Schaltung
gegen ein bekanntes Potential für die
Erfassung und Ausgabe von Analog- und
Digitalsignalen sowie für die +5-VDC-
Stromversorgung und die +2,5-VDC-
Spannung des Steckverbinders.
Ausgabepunkt des Ruhestroms bei
differentiellen Messungen.

AI <0..7> Unterschiedlich Eingang Analoge Eingänge 0 bis 7—Bei Messungen
gegen ein Bezugspotential ist jeder Kanal
ein analoger Spannungseingang. Bei der
Messung in differentieller Schaltung sind
AI 0 und AI 4 der positive und der negative
Eingang für den differentiellen analogen
Eingangskanal 0. Weitere Kanalpaare für
differentielle Messungen sind AI <1, 5>,
AI <2, 6> und AI <3, 7>. Weitere
Informationen finden Sie im Abschnitt 
Analoge Erfassung.

AO <0, 1> GND Ausgang Kanäle 0 und 1 zur Ausgabe von
Analogsignalen—Stellt die Spannung für
die Spannungsausgänge 0 und 1 bereit.
Weitere Informationen finden Sie im
Abschnitt Analoge Ausgabe.

P0.<0..7> GND Ein- oder
Ausgang

Digital-I/O-Kanäle 0 bis 7 (Port 0)—Jeder
dieser Anschlüsse kann als Ein- oder
Ausgang konfiguriert werden. Weitere
Informationen finden Sie im Abschnitt 
Digital-I/O.

P1.<0..3> GND Ein- oder
Ausgang

Digital-I/O-Kanäle 0 bis 3 (Port 1)—Jeder
dieser Anschlüsse kann als Ein- oder
Ausgang konfiguriert werden. Weitere
Informationen finden Sie im Abschnitt 
Digital-I/O.
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Tabelle 5. Signalbeschreibungen (Fortsetzung)

Signalname Bezugsanschluss Richtung Beschreibung

    PFI 0 GND Eingang PFI 0—Dieser Anschluss kann entweder als
Digital-Trigger oder als Zählereingang
konfiguriert werden. Weitere Informationen
finden Sie im Abschnitt PFI 0.

+2,5 V GND Ausgang Externe +2,5-V-Bezugsspannung—
Bezugsspannung für Fehlertests von ICs, bei
denen formatierte Ausgangsdaten vor der
Übertragung in den Eingang zurückgeführt
werden, um Fehler in der Datenformatierung
zu erkennen. Weitere Informationen finden
Sie im Abschnitt Externe +2,5-V-
Bezugsspannung.

+5 V GND Ausgang +5-V-Spannungsquelle—Gibt eine +5-V-
Spannung mit einem Strom bis zu 200 mA
aus. Weitere Informationen finden Sie im
Abschnitt +5-Volt-Spannungsversorgung.

Analoge Erfassung
Das NI USB-6008/6009 ist mit acht Analogeingängen ausgestattet, mit denen vier Messungen
in differentieller Schaltung oder acht Messungen gegenüber einem Bezugspotential
durchgeführt werden können.

In der nachfolgenden Abbildung ist die Beschaltung eines Analogeingangs des
NI USB-6008/6009 dargestellt.

Abbildung 7. Analogeingangsbeschaltung des NI USB-6008/6009
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Die Beschaltung des Analogeingangs des NI USB-6008/6009 setzt sich hauptsächlich aus
folgenden Blöcken zusammen:
• MUX—Das NI USB-6008/6009 ist mit einem integrierten A/D-Wandler ausgestattet. Der

Multiplexer (MUX) führt jeweils einen Analogeingangskanal durch den Programmable-
Gain-Verstärker (PGA).

• PGA—Der PGA arbeitet bei der Schaltung gegen ein Bezugspotential mit dem
Verstärkungsfaktor 1. Bei differentieller Schaltung kann der Verstärkungsfaktor 1, 2, 4, 5,
8, 10, 16 oder 20 lauten. Die Verstärkung wird automatisch anhand des
Spannungsbereichs in der Messanwendung berechnet.

• A/D-Wandler—Der A/D-Wandler wandelt die anliegenden Analogspannungen in
digitale Daten um.

• AI-FIFO—Das NI USB-6008/6009 kann A/D-Wandlungen an einer festen Sample-
Anzahl und an fortlaufend eingehenden Samples durchführen, wobei die Samples einzeln
oder blockweise umgewandelt werden können. Die eingehenden Analogdaten werden in
einem FIFO gespeichert, so dass keine Daten verlorengehen.

Schaltungsarten und Signalquellen der
Analogeingänge
Die Analogeingänge des NI USB-6008/6009 können gegen ein Bezugspotential oder
differentiell geschaltet werden. In der nachfolgenden Tabelle werden die empfohlenen
Schaltungsarten für erdfreie und geerdete Signalquellen zusammengefasst. In der Tabelle im
Abschnitt Pinbelegung und Signalbeschreibungen finden Sie weitere Informationen zum
Anschließen des Geräts für differentielle Messungen oder Messungen gegen Bezugsgröße.
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Tabelle 6. Schaltungsarten der Analogeingänge

Schaltungsart Erdfreie Signalquellen (nicht mit
der Gebäudeerde verbunden)

Geerdete Signalquellen

   Beispiele • Nicht geerdete
Thermoelemente

• Signalaufbereitung mit
isolierten Ausgängen

• Batterien

Plugin-Geräte mit nicht isolierten
Ausgängen

Differentiell
(DIFF)

+
–

+

–

AI+ 

AI– 

GND

Signalquelle NI USB-6008/6009

+
–

+

–

AI+ 

AI– 

GND

Signalquelle NI USB-6008/6009

Gegenüber Erde
(RSE)

+
–

+

–

AI 

GND

Signalquelle NI USB-6008/6009

           Potentialdifferenz (UA – UB) wird zum
                Messsignal addiert.

NICHT EMPFOHLEN

+
–

+

–

AI 

GND
UB

UA

Signalquelle NI USB-6008/6009

Erdfreie Signalquellen
Eine erdfreie Signalquelle ist nicht mit dem Erdungssystem des Gebäudes verbunden, sondern
besitzt einen isolierten Potentialbezugspunkt. Zu den erdfreien Signalquellen gehören z. B.
Ausgangsspulen von Transformatoren, batteriebetriebene Geräte, Ausgänge von optischen
Isolatoren und Isolationsverstärker. Ein Gerät mit isoliertem Ausgang ist eine erdfreie
Signalquelle.

Weitere Informationen finden Sie im Artikel Field Wiring and Noise Considerations for
Analog Signals. Zum Öffnen dieses Artikels besuchen Sie ni.com/info und geben Sie den
Infocode rdfwn3 ein.
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Kriterien für das differentielle Anschließen (erdfreie Signalquellen)
Alle Kanäle, die eine der folgenden Bedingungen erfüllen, sind differentiell anzuschließen:
• Die Anwendung arbeitet mit anderen Eingangsbereichen als ±10 V.
• Eine geringe Signalamplitude macht eine größere Genauigkeit erforderlich.
• Die Leitungen zwischen Gerät und Signalquelle sind länger als 3 m.
• Für das Eingangssignal ist ein separater Erdungspunkt oder ein separates Rücksignal

erforderlich.
• Die Signalleitungen befinden sich in einer störungsreichen Umgebung.
• Für das Signal sind die Analogkanäle AI+ und AI- verfügbar.

Rauschen und Gleichtaktstörungen lassen sich durch differentielle Schaltung unterdrücken.
Differentiell geschaltete Eingangssignale können sich außerdem potentialfrei innerhalb der
Arbeitsspannung des Geräts bewegen ("floaten").

Weitere Informationen zu differentiellen Schaltungen finden Sie im Abschnitt Durchführen
von differentiellen Messungen.

Kriterien für das Anschließen gegenüber Erde (erdfreie Signalquellen)
Eingänge sind gegenüber Erde (RSE) anzuschließen, wenn das Eingangssignal alle folgenden
Bedingungen erfüllt:
• Das Eingangssignal kann einen gemeinsamen Bezugspunkt (GND) mit anderen Signalen

haben.
• Ihre Anwendung arbeitet mit dem Eingangsbereich ±10 V.
• Die Leitungen zwischen Gerät und Signalquelle sind kürzer als 3 m.

Für alle Signale, die diese Bedingungen nicht erfüllen, wird die differentielle Schaltung
empfohlen, da das Signal dadurch weniger Störeinflüssen unterliegt.

Bei der Schaltung gegenüber einem Bezugspotential wird mehr elektrostatisches und
magnetisches Rauschen in die Signalanschlüsse eingekoppelt als bei der differentiellen
Schaltung. Die Kopplung ergibt sich aus Unterschieden im Signalweg. Magnetische Kopplung
ist proportional zur Fläche zwischen den zwei Signalleitern. Elektrische Kopplung hängt
davon ab, wie stark sich das elektrische Feld zwischen den zwei Leitern unterscheidet.

Bei dieser Art der Verbindung schaltet der PGA sowohl Gleichtaktstörungen im Signal als
auch die Bezugspotentialdifferenz zwischen der Signalquelle und der Geräteerde aus.

Weitere Informationen zur Schaltung gegenüber einem Bezugspotential finden Sie im
Abschnitt Durchführen von Messungen gegenüber Erde.

Geerdete Signalquellen
Eine geerdete Signalquelle ist mit der Erdungsanlage eines Gebäudes verbunden. Sie hat
bereits einen gemeinsamen Bezugspunkt mit dem Gerät – vorausgesetzt, der Computer ist an
dasselbe Stromnetz wie die Signalquelle angeschlossen. In diese Kategorie fallen z. B. nicht
isolierte Ausgänge von (Mess-)Geräten, die mit dem Stromnetz des Gebäudes verbunden sind.
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Die Erdpotentialdifferenz zwischen zwei Messgeräten, die an dasselbe Stromnetz eines
Gebäudes angeschlossen sind, liegt in der Regel zwischen 1 mV und 100 mV. Wenn Kabel in
der Gebäudeinstallation nicht ordnungsgemäß angeschlossen sind, kann der Unterschied
größer sein. Wenn eine geerdete Signalquelle falsch angeschlossen wird, kann sich diese
Differenz als Messfehler bemerkbar machen. Folgen Sie der Anleitung für das Anschließen
geerdeter Signalquellen, um die Erdpotentialdifferenz zu eliminieren.

Weitere Informationen finden Sie im Artikel Field Wiring and Noise Considerations for
Analog Signals. Zum Öffnen dieses Artikels besuchen Sie ni.com/info und geben Sie den
Infocode rdfwn3 ein.

Kriterien für das differentielle Anschließen (geerdete Signalquellen)
Alle Kanäle, die eine der folgenden Bedingungen erfüllen, sind differentiell anzuschließen:
• Die Anwendung arbeitet mit anderen Eingangsbereichen als ±10 V.
• Eine geringe Signalamplitude macht eine größere Genauigkeit erforderlich.
• Die Leitungen zwischen Gerät und Signalquelle sind länger als 3 m.
• Für das Eingangssignal ist ein separater Erdungspunkt oder ein separates Rücksignal

erforderlich.
• Die Signalleitungen befinden sich in einer störungsreichen Umgebung.
• Für das Signal sind die Analogkanäle AI+ und AI- verfügbar.

Rauschen und Gleichtaktstörungen lassen sich durch differentielle Schaltung unterdrücken.
Differentiell geschaltete Eingangssignale können sich außerdem potentialfrei innerhalb der
Arbeitsspannung des Geräts bewegen ("floaten").

Weitere Informationen zu differentiellen Schaltungen finden Sie im Abschnitt Durchführen
von differentiellen Messungen.

Kriterien für das Anschließen gegenüber Erde (geerdete Signalquellen)
Verwenden Sie für geerdete Signalquellen nie die Anschlussart gegenüber Erde. Schließen Sie
sie stattdessen differentiell an.

Wie in der Tabelle im Abschnitt Schaltungsarten und Signalquellen der Analogeingänge
dargestellt, kann zwischen dem GND-Anschluss des NI-USB 6008/6009 und dem
Bezugspotential der Signalquelle eine Potentialdifferenz vorliegen. Durch diese
Potentialdifferenz werden bei dieser Schaltungsart Messfehler verursacht.

Durchführen von differentiellen Messungen
Bei differentiellen Signalen ist die positive Leitung mit AI+ und die negative Leitung mit AI-
zu verbinden.
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Abbildung 8. Differentielles Anschließen von Spannungen
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Bei differentieller Schaltung können Signale im Bereich von ±20 V gemessen werden. Die
Maximalspannung an jedem beliebigen Eingang ist daher ±10 V gegenüber GND. Wenn Sie
beispielsweise +10 V an AI 1 anlegen und -10 V an AI 5, gibt das Gerät +20 V aus.

Abbildung 9. Beispiel für eine differentielle 20-V-Messung
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Wenn Sie ein Signal größer als ±10 V an einen der Eingänge anschließen, wird das
Ausgangssignal abgeschnitten.

Abbildung 10. Abgeschnittenes Signal bei Überschreitung von ±10 V

–5

–10

–15

–20

20

15

10

5

0

A
m

pl
itu

de
 (

V
)

AI 1

AI 5

Ergebnis

NI USB-6008/6009 Bedienungsanleitung | © National Instruments | 17



Durchführen von Messungen gegenüber Erde
Zum Anschließen von Signalen des NI USB-6008/6009 gegenüber Erde verbinden Sie die
positive Ader mit dem gewünschten Analogeingang und die negative Ader mit dem GND-
Anschluss, wie in der folgenden Abbildung dargestellt.

Abbildung 11. Anschließen von Signalen gegenüber Erde
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NI USB-6008/6009

GND

Spannungs-
quelle

Wenn die Schaltung gegenüber Erde ausgewählt ist und keine Signale an den Analogeingang
angeschlossen sind, kann der Eingang aufgrund des integrierten Widerstandsteilers eine
Spannung von etwa 1,4 V ausgeben. Das ist normal und hat bei ordnungsgemäßer Verdrahtung
keinen Einfluss auf die Messung.

Digital-Trigger
An PFI 0 kann für Tasks zur Erfassung von Analogsignalen ein digitaler Trigger angelegt
werden. Weitere Informationen finden Sie im Abschnitt Verwenden von PFI 0 als Digital-
Trigger.

Analoge Ausgabe
Das NI USB-6008/6009 ist mit zwei unabhängigen Analogausgängen ausgestattet, die
Spannungen im Bereich von 0 V bis 5 V ausgeben können. Das Timing der Analogausgabe ist
softwaregesteuert. GND ist der Bezugsanschluss für Analogausgänge.

In der folgenden Abbildung ist die Beschaltung eines Analogausgangs des NI USB-6008/6009
dargestellt.
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Abbildung 12. Beschaltung eines Analogausgangs
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Das Kernstück der Schaltung für den Analogausgang des NI USB-6008/6009 ist der
D/A-Wandler, der digitale Signaldaten in analoge Spannungen umwandelt. Jedem
Analogausgang ist ein D/A-Wandler vorgeschaltet.

Anschließen von Lasten an den Analogausgang
Zum Anschließen von Lasten an das NI USB-6008/6009 verbinden Sie entsprechend der
folgenden Abbildung die positive Ader der Last mit dem Analogausgang und die Ader mit
GND.

Abbildung 13. Anschließen einer Last

NI USB-6008/6009

GND

AO

Last

Minimieren von Spannungsspitzen im Ausgangssignal
Wenn Sie ein Signal mit einen D/A-Wandler erzeugen, können Spannungsspitzen im
Ausgangssignal auftreten. Diese Spannungsspitzen sind normal; sie werden durch Entladungen
verursacht, wenn der Wandler von einer Spannung auf eine andere schaltet. Die größten
Spannungsspitzen treten auf, wenn sich das höchstwertige Bit des D/A-Wandler-Codes ändert.
Je nach der Frequenz und Art des Ausgangssignals lassen sich die Spitzen durch einen
Entstörfilter entfernen, der einen Tiefpass enthält. Weitere Informationen zum Minimieren
unerwünschter Spannungsspitzen finden Sie im KnowledgeBase-Artikel Reducing Glitches on
the Analog Output of MIO DAQ Devices. Zum Öffnen dieses Artikels besuchen Sie ni.com/
info und geben Sie den Infocode exszek ein.
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Digital-I/O
Das NI USB-6008/6009 enthält zwei Ports mit insgesamt 12 Digitalanschlüssen. Port 0
umfasst acht Anschlüsse (P0.0..7) und Port 1 vier Anschlüsse (P1.0..3). GND ist der
Masseanschluss für die digitalen Ports. Alle Anschlüsse können entweder als Ein- oder
Ausgänge konfiguriert werden.

In der folgenden Abbildung sehen Sie ein Beispiel für die Verdrahtung der Digitalanschlüsse
P0.0..7, die als digitale Ein- und Ausgänge konfiguriert sind. P1.0..3 können auf die gleiche
Weise konfiguriert werden.

Abbildung 14. Beispiel für das Anschließen einer Last
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NI USB-6008/6009

1. P0.0, konfiguriert als digitaler Ausgang (offener
Kollektor) zum Ansteuern einer LED

2. P0.2, konfiguriert als aktiver digitaler Ausgang
zum Ansteuern einer LED

3. P0.4, konfiguriert als digitaler Eingang zum
Empfangen eines TTL-Signals von einem Inverter

4. P0.7, konfiguriert als digitaler Eingang zum
Empfangen eines 0- oder 5-Volt-Signals von
einem Schalter

Achtung  Wenn die maximal zulässige Ein- oder Ausgangsspannung überschritten
wird, kann es zu Schäden am Gerät und am Computer kommen. National
Instruments übernimmt keine Haftung für Schäden aufgrund unsachgemäßer
Nutzung. Weitere Informationen finden Sie unter Gerätespezifikationen zum
NI USB-6008 oder Gerätespezifikationen zum NI USB-6009 .

Angaben zu Quelle/Senke
Per Voreinstellung sind die Digitalanschlüsse des NI USB-6008/6009 mit einem
Bipolartransistor mit freiem Kollektor-Ausgang ausgestattet, der mit Hilfe des 4,7-kΩ-Pull-
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Up-Widerstands des Geräts mit 5 V betrieben werden kann. Durch Zuschalten eines Pull-Up-
Widerstands an den Anschluss (vgl. Abbildung) können Sie den maximalen Quellstrom auf
8,5 mA pro Leitung erhöhen.4

Abbildung 15. Beispiel für das Anschließen eines Widerstands
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Die Anschlüsse des NI USB-6009 können mit Hilfe der NI-DAQmx-API auch als aktive Ein-
und Ausgänge konfiguriert werden, die eine Spannung von 3,3 Volt und einen Strom von
±8,5 mA zulassen. Weitere Informationen zum Konfigurieren der Digitalanschlüsse finden Sie
im KnowledgeBase-Artikel How Do I Configure My NI Device to be Open-Drain (Open
Collector) or Push-Pull (Active Drive)? Zum Öffnen dieses Artikels besuchen Sie ni.com/
info und geben Sie den Infocode ex52sp ein.

Ermitteln des Werts des Pull-Up-Widerstands
Um den Wert des Widerstands zu ermitteln, der von außen zugeschaltet werden muss, gehen
Sie wie folgt vor:
1. Schalten Sie einen Strommesser in Reihe mit der Last.
2. Fügen Sie ein Potentiometer zwischen dem Digitalausgang und der +5-Volt-Versorgung

ein.
3. Schalten Sie P0.0 auf High.
4. Drehen Sie am Potentiometer, bis der Strommesser den gewünschten Strom anzeigt. Der

Strom muss unter 8,5 mA liegen.
5. Entfernen Sie das Potentiometer und den Strommesser aus der Schaltung.
6. Messen Sie den Widerstand des Potentiometers. Der gemessene Widerstand ist der

Idealwert für den Pull-Up-Widerstand.

4 In diesem Dokument werden NI-DAQmx-Namenskonventionen verwendet. "Open Drain" wird
dabei als "offener Kollektor" bezeichnet und "Push-Pull" als "aktive Ausgabe".
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7. Der tatsächliche Wert Ihres Widerstands sollte größer gleich dem Idealwert sein.
8. Schalten Sie den Widerstand anschließend in den Lastschaltkreis ein.

Schutz der Anschlüsse vor Spannungsspitzen und
Überströmen
Zum Schutz des NI USB-6008/6009 vor Überspannungen, Unterspannungen, Überströmen
und elektrostatischen Entladungen sollten Sie folgende Hinweise beachten:
• Als Ausgang konfigurierte Digitalanschlüsse dürfen nicht mit Signal- oder

Masseleitungen verbunden werden. Ebenso wenig darf dem Anschluss eine
Versorgungsspannung zugeführt werden.

• Beim Anschalten von Lasten an Digitalausgänge sollten die Spezifikationen beachtet
werden. Die angegebenen Maximalströme des DAQ-Geräts dürfen nicht überschritten
werden.
National Instruments bietet unterschiedliche Systeme zur Signalaufbereitung für digitale
Schaltungen an, die mit hohen Strömen arbeiten.

• Als Eingang konfigurierte Digitalanschlüsse dürfen nicht mit Spannungen außerhalb des
zulässigen Eingangsbereichs betrieben werden. Digitalanschlüsse haben einen kleineren
Ein- und Ausgangsbereich als analoge Eingänge.

• Das DAQ-Gerät ist wie jedes andere elektrostatisch empfindliche Gerät zu behandeln.
Erden Sie sich und die verwendeten Werkzeuge, bevor Sie das Gerät berühren oder
Leitungen anschließen.

Einschaltzustände
Nach dem Starten und Zurücksetzen des Geräts sind alle Digitalanschlüsse hochohmige
Eingänge. Das Gerät gibt also kein High- oder Low-Signal aus. Jeder Anschluss ist intern mit
einem niederohmigen Pull-Up-Widerstand verbunden.

Statische Leitungen
Jeder Digitalanschluss des NI USB-6008/6009 kann als Ein- oder Ausgang für die statische
Digital-I/O genutzt werden. Mit den statischen Digitalleitungen können Digitalsignale
überwacht und gesteuert werden. Alle statischen Ein- und Ausgänge arbeiten mit Software-
Timing.

PFI 0
PFI 0 kann entweder als Digital-Trigger-Eingang oder als Zählereingang konfiguriert werden.

Verwenden von PFI 0 als Digital-Trigger
Wenn ein Task zur analogen Erfassung erstellt wurde, können Sie PFI 0 als Digital-Trigger-
Eingang konfigurieren. Bei aktiviertem Digital-Trigger wartet der Erfassungs-Task vor dem
Beginn der Erfassung auf eine steigende oder fallende Flanke an PFI 0. Zur Verwendung von

22 | ni.com | NI USB-6008/6009 Bedienungsanleitung



"AI-Start-Trigger" (ai/Start Trigger) mit einer Digitalquelle geben Sie PFI 0 als Quelle an und
wählen Sie die Flankenrichtung aus.

Verwenden von PFI 0 als Zähler
PFI 0 kann auch als Eingang für die Zählung digitaler Flanken konfiguriert werden. In diesem
Modus werden alle Impulse mit fallender Flanke durch den 32-Bit-Zähler erfasst.
Informationen zur Timing-Genauigkeit und -Auflösung finden Sie in den Dokumenten
Gerätespezifikationen zum NI USB-6008 und Gerätespezifikationen zum NI USB-6009 unter
ni.com/manuals.

Externe Bezugs- und Versorgungsspannung
Das NI USB-6008/6009 gibt eine Bezugs- und eine Versorgungsspannung aus. Alle
Spannungen beziehen sich auf GND.

Externe +2,5-V-Bezugsspannung
Mit Hilfe eines mehrstufigen Regler-, Verstärker- und Filterschaltkreises erzeugt das
NI USB-6008/6009 eine nahezu ideale Versorgungsspannung für den A/D-Wandler. Die
daraus resultierende +2,5-Volt-Bezugsspannung kann für Selbsttests des Geräts verwendet
werden.

+5-Volt-Spannungsversorgung
Das NI USB-6008/6009 gibt eine Versorgungsspannung von 5 V mit einem Strom von
200 mA aus. Mit der Versorgungsspannung können angeschlossene Geräte betrieben werden.

Hinweis  Wenn sich das Gerät im USB-Suspend-Modus befindet, sind alle
Ausgänge deaktiviert.

Weiterführende Informationen
In diesem Abschnitt erfahren Sie, wo Sie Beispielprogramme und relevante Dokumentation
zum NI USB-6008/6009 finden.

Beispielprogramme
NI-DAQmx und NI-DAQmx Base enthalten Beispielprogramme, die Ihnen den Einstieg in die
Programmierung mit dem NI USB-6008/6009 erleichtern sollen. Sie können Beispiele beliebig
ändern und in eigene Anwendungen einfügen. Ebenso können Sie von Beispielen ausgehend
neue Anwendungen entwickeln.

NI-DAQmx
Beispiele zu Software von National Instruments finden Sie auf ni.com/info nach Eingabe
des Infocodes daqmxexp.
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Mit der NI-DAQmx-Simulationsfunktion lassen sich Beispiele auch ohne angeschlossenes
Gerät ausführen. Wie ein Gerät simuliert wird, ist im Measurement & Automation Explorer
(MAX) unter Hilfe»Hilfethemen»NI-DAQmx»MAX-Hilfe zu NI-DAQmx beschrieben.

NI-DAQmx Base
Beispiele zu NI-DAQmx Base werden über Start»Alle Programme»National Instruments»
NI-DAQmx Base Examples geöffnet.

Literaturhinweise
In jeder Entwicklungsumgebung und jedem Treiber von National Instruments wird
beschrieben, wie Programme zum Durchführen von Messungen und zum Steuern von
Messgeräten erstellt werden. Die folgenden Literaturhinweise gelten für NI-DAQmx 9.3 oder
neuere NI-DAQmx-Versionen und (sofern zutreffend) für Entwicklungsumgebungen von
National Instruments der Version 8.5 oder höher.

NI USB-6008/6009
Im Dokument Schnellstartanleitung für NI USB-6008/6009 , das mit dem NI USB-6008/6009
geliefert wird, erfahren Sie, wie Sie die NI-DAQmx-Software installieren, das Gerät
anschließen und das Gerät auf korrekte Funktionsweise prüfen.

Die Dokumente Gerätespezifikationen zum NI USB-6008 und Gerätespezifikationen zum
NI USB-6009 enthalten Gerätespezifikationen und sind auf ni.com/manuals verfügbar.

NI-DAQmx
Die Readme zu NI-DAQ kann über das Windows-Startmenü aufgerufen werden und listet auf,
welche Anwendungssoftware, Geräte und Entwicklungsumgebungen von dieser Version von
NI-DAQmx unterstützt werden.

Die Hilfe zu NI-DAQmx kann über das Windows-Startmenü aufgerufen werden und enthält
API-Übersichten, allgemeine Begriffsdefinitionen zur Messtechnik, eine Einführung in NI-
DAQmx sowie allgemeine Anleitungen zum Erfassen oder Erzeugen von Daten, die
unabhängig von der Entwicklungsumgebung gelten.

NI-DAQmx Base (Linux/Mac OS X/LabVIEW PDA 8.x)
Im Dokument Getting Started with NI-DAQmx Base wird die Installation von NI-DAQmx
Base beschrieben und Sie erfahren, wie Sie ein unterstütztes Gerät anschließen und die
Funktionsweise des Geräts auf einem Linux- oder Mac-Computer prüfen. Zum Öffnen des
Dokuments unter Windows klicken Sie auf Start»Alle Programme»National Instruments»
NI-DAQmx Base»Documentation»Getting Started with NI-DAQmx Base.

In der NI-DAQmx Base Readme werden alle von einer NI-DAQmx-Base-Version unterstützten
Geräte aufgeführt. Zum Öffnen der Datei unter Windows wählen Sie Start»Alle Programme»
National Instruments»NI-DAQmx Base»DAQmx Base Readme.
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Die NI-DAQmx Base VI Reference Help enthält eine Übersicht über die NI-DAQmx-VIs und
allgemeine Erklärungen zur Messtechnik. Zum Öffnen der Hilfe klicken Sie in LabVIEW auf
Hilfe»NI-DAQmx Base VI Reference Help.

Die NI-DAQmx Base C Function Reference Help enthält eine Übersicht über die C-Funktionen
für NI-DAQmx und allgemeine Erklärungen zur Messtechnik. Zum Öffnen der Hilfe unter
Windows klicken Sie auf Start»Alle Programme»National Instruments»NI-DAQmx Base»
Documentation»C Function Reference Help.

Hinweis  Die gesamte Dokumentation zu NI-DAQmx Base für Linux wird
unter /usr/local/natinst/nidaqmxbase/documentation installiert.

Hinweis  Die gesamte Dokumentation zu NI-DAQmx Base für Mac OS X wird
unter /Applications/National Instruments/NI-DAQmx Base/
documentation installiert.

LabVIEW
Auf ni.com/gettingstarted erhalten Sie weitere Informationen zu LabVIEW.

In der LabVIEW -Hilfe, die in LabVIEW über Hilfe»LabVIEW -Hilfe geöffnet wird, finden
Sie Informationen zu den Grundlagen der Programmierung mit dieser
Entwicklungsumgebung, detaillierte Anleitungen zur Bedienung von LabVIEW sowie
Hinweise zu den VIs, Funktionen, Paletten, Menüs und Werkzeugen des Programms.
Informationen zu NI-DAQmx finden Sie über die Registerkarte Inhalt der LabVIEW-Hilfe
unter folgenden Überschriften:
• VI- und Funktionenübersicht »VIs und Funktionen für Mess-I/O »Palette "DAQmx

- Datenerfassung" —Enthält Beschreibungen der LabVIEW-VIs und -Funktionen von
NI-DAQmx.

• Eigenschaften und Methodenübersicht »NI-DAQmx-Eigenschaften —Enthält
Beschreibungen der Eigenschaften von NI-DAQmx.

• Durchführen von Messungen—Beschreibt, wie Messwerte in LabVIEW erfasst und
ausgewertet werden, und enthält Definitionen der wichtigsten NI-DAQmx-Termini,
allgemeine Informationen zur Messtechnik sowie Hinweise zur Messhardware von
National Instruments.

LabWindows/CVI
Der Abschnitt Data Acquisition der LabWindows/CVI Help enthält den Abschnitt Taking an
NI-DAQmx Measurement in LabWindows/CVI, in dem schrittweise das Erstellen eines Mess-
Tasks mit Hilfe des DAQ-Assistenten beschrieben ist. Klicken Sie zum Öffnen der Hilfe in
LabWindows/CVI auf Help»Contents und wählen Sie Using LabWindows/CVI»Data
Acquisition aus. Das Buch enthält außerdem Verweise auf detailliertere Beschreibungen in der
Hilfe zu NI-DAQmx.

Im Abschnitt NI-DAQmx Library der LabWindows/CVI Help finden Sie eine Beschreibung
der NI-DAQmx-API von LabWindows/CVI einschließlich einer Übersicht über die einzelnen
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NI-DAQmx-Funktionen. Zum Öffnen dieses Abschnitts klicken Sie in der LabWindows/CVI
Help auf Library Reference»NI-DAQmx Library.

Measurement Studio
Wenn Sie Ihr von NI-DAQmx unterstütztes Gerät in Measurement Studio mit Hilfe von Visual
C# oder Visual Basic .NET programmieren, können Sie interaktiv Kanäle und Tasks erstellen,
indem Sie den DAQ-Assistenten vom MAX oder Visual Studio aus starten. Sie können den
Konfigurationscode auf Grundlage Ihres Tasks oder Kanals in Measurement Studio erzeugen.
Weitere Informationen zur Erzeugung von Programmcode finden Sie in der Hilfe zum DAQ-
Assistenten.

Die NI Measurement Studio Help ist vollständig in die Hilfe zu Microsoft Visual Studio
integriert. Zum Öffnen der Hilfe in Visual Studio wählen Sie Measurement Studio»NI
Measurement Studio Help. Weitere Hinweise zum Entwickeln von Anwendungen mit
NI-DAQmx finden Sie in folgenden Abschnitten der NI Measurement Studio Help:
• Anleitungen zum Erstellen von Anwendungen mit dem Measurement Studio Application

Wizard oder dem DAQ-Assistenten finden Sie unter Walkthrough: Creating a
Measurement Studio NI-DAQmx Application.

• Hilfe zu den Eigenschaften und Methoden von NI-DAQmx finden Sie unter
NationalInstruments.DAQmx Namespace und
NationalInstruments.DAQmx.ComponentModel Namespace.

• Grundsätzliche Informationen zu NI-DAQmx finden Sie unter Using the Measurement
Studio NI-DAQmx .NET Library und Developing with Measurement Studio NI-DAQmx.

• Allgemeine Hilfe zur Programmierung in Measurement Studio finden Sie unter Getting
Started with the Measurement Studio Class Libraries.

Zum Erstellen einer Anwendung in Visual Basic .NET oder Visual C# führen Sie folgende
allgemeinen Schritte aus:
1. Klicken Sie in Visual Studio auf File»New»Project. Daraufhin öffnet sich das Dialogfeld

"New Project".
2. Erweitern Sie unter "Project types" je nach verwendeter Programmiersprache den Knoten

Visual Basic oder Visual C# und wählen Sie anschließend Measurement Studio.
3. Wählen Sie einen Projekttyp aus. In diesem Schritt fügen Sie DAQ-Tasks hinzu.

ANSI C ohne Entwicklungsumgebung von National Instruments
Die Hilfe zu NI-DAQmx Help enthält eine Übersicht über die NI-DAQmx-API und allgemeine
Erklärungen zur Messtechnik. Klicken Sie zum Starten der Hilfedatei auf Start»Alle
Programme»National Instruments»NI-DAQmx»NI-DAQmx-Hilfe.

Die NI-DAQmx C Reference Help beschreibt die Funktionen der NI-DAQmx Library, mit
deren Hilfe Datenerfassungsgeräte von National Instruments in Anwendungen der Mess- und
Automatisierungstechnik eingebunden und gesteuert werden. Klicken Sie zum Starten der
Hilfedatei auf Start»Alle Programme»National Instruments»NI-DAQmx»Text-Based
Code Support»NI-DAQmx C Reference Help.
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.NET-Sprachen ohne Entwicklungsumgebung von National
Instruments
Mit dem Microsoft .NET Framework haben Sie die Möglichkeit, NI-DAQmx-Anwendungen
in Visual C# und Visual Basic .NET zu erstellen, ohne dass Sie dazu Measurement Studio
brauchen. In der Readme zu NI-DAQmx finden Sie eine Liste der unterstützten Versionen.

Kurse
National Instruments bietet Softwareschulungen an, in denen Sie Ihre Kenntnisse über die
Arbeit mit NI-Produkten vertiefen können. Informationen zu den Kursinhalten und zur
Anmeldung finden Sie auf der Website ni.com/training.

Technische Unterstützung im Web
Weitere Unterstützung finden Sie auf der Website ni.com/support oder ni.com/
examples.

Hinweis  Zum Herunterladen dieser Beschreibungen besuchen Sie die Website
ni.com/manuals.

Viele DAQ-Spezifikationen und DAQ-Anleitungen sind als PDF-Dateien verfügbar. Zur
Anzeige der PDF-Dokumente benötigen Sie mindestens Adobe Reader 7.0 (mindestens PDF
1.6). Den Acrobat Reader können Sie auf der Adobe-Website unter www.adobe.de
herunterladen. Die jeweils aktuelle Version der Handbücher finden Sie in der
Produktbibliothek von National Instruments unter ni.com/manuals.

Support und Serviceleistungen weltweit
Die Website von National Instruments bietet verschiedene Ressourcen für den technischen
Support. Unter ni.com/support erhalten Sie Zugriff auf Informationen zur Fehlersuche und
Entwicklung von Anwendungen sowie Möglichkeiten zum Anfordern persönlicher technischer
Unterstützung per E-Mail oder Telefon.

Die Seite ni.com/services enthält Informationen zur Lieferung sofort einsatzbereiter Systeme
sowie zu Reparaturen, Garantieverlängerungen und anderen Serviceleistungen von National
Instruments.

Auf ni.com/register können Sie Ihr Produkt von National Instruments registrieren. Die
Produktregistrierung erleichtert den technischen Support und die Zusendung wichtiger
Update-Informationen.

Anhand der Konformitätserklärung (DoC) wird bescheinigt, dass National Instruments unter
Verwendung der Konformitätserklärungen der entsprechenden Hersteller die EU-Richtlinien
zum Verbraucherschutz einhält. Mit der DoC werden elektromagnetische Verträglichkeit und
Sicherheit unserer Produkte garantiert. Das Zertifikat zu Ihrem Produkt finden Sie auf ni.com/
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certification. Wenn Ihr Gerät kalibrierbar ist, finden Sie auf ni.com/calibration das zugehörige
Kalibrierzertifikat.

Die Adresse der Hauptniederlassung von National Instruments lautet:
11500 North Mopac Expressway, Austin, Texas, 78759-3504, USA. National Instruments
unterhält Niederlassungen auf der ganzen Welt. Für telefonischen Support innerhalb der USA
können Sie entweder auf ni.com/support eine entsprechende Anfrage einreichen oder die
Telefonnummer 1 866 ASK MYNI (275 6964) anrufen. Um außerhalb der USA telefonischen
Support anzufordern, wählen Sie auf der Webseite Worldwide Offices unter ni.com/niglobal Ihr
Land aus. Die daraufhin geöffnete Webseite enthält aktuelle Kontaktinformationen,
Telefonnummern des technischen Supports, E-Mail-Adressen sowie Informationen zu
Veranstaltungen.

Weitere Informationen zu Marken von National Instruments finden Sie in den NI Trademarks and Logo Guidelines auf ni.com/
trademarks. Sonstige hierin erwähnte Produkt- und Firmenbezeichnungen sind Marken oder Handelsnamen der jeweiligen
Unternehmen. Nähere Informationen über den Patentschutz von Produkten/Technologien von National Instruments finden Sie
unter Hilfe»Patente in Ihrer Software, in der Datei patents.txt auf Ihrem Datenträger oder unter National Instruments Patent
Notice auf der Website ni.com/patents. Informationen zu Endbenutzer-Lizenzverträgen (EULAs) und Rechtshinweisen von
Drittanbietern finden Sie in der Readme zu Ihrem Produkt von National Instruments. Informationen zu den Global-Trade-
Compliance-Richtlinien von National Instruments sowie zu Bezugsquellen für relevante HTS-Codes, ECCNs und andere Import-/
Exportangaben finden Sie auf ni.com/legal/export-compliance unter der Überschrift Export Compliance Information. NI
übernimmt jedoch weder ausdrücklich noch stillschweigend irgendeine Gewährleistung für die Richtigkeit oder Vollständigkeit der
in diesem Dokument enthaltenen Informationen und haftet nicht für Fehler. Kunden aus US-Regierungsbehörden: Die in diesem
Dokument enthaltenen Informationen wurden auf private Kosten entwickelt und unterliegen den anwendbaren beschränkten
Rechten und beschränkten Datenrechten, die in FAR 52.227-14, DFAR 252.227-7014 und DFAR 252.227-7015 dargelegt sind.
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